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6 Steps to Follow 
 
A mail merge is the process of merging a list of names and addresses with 
another document. You can begin a mail merge in Microsoft Outlook, Word, 
or Access, but you MUST COMPLETE THE MAIL MERGE IN WORD. 
 
There are six major steps in every mail merge: 

1. Select the document type 
2. Select the starting document 
3. Select recipients 
4. Insert merge fields 
5. Preview the documents, and 
6. Complete the merge. 

 

The Mail Merge Task Pane 
The Mail Merge task pane allows you to follow step-by-step instructions 
provided by the Mail Merge Wizard. Your document remains open and visible 
while you use the wizard. To display the Mail Merge task pane, select Letters and 
Mailings from the Tools menu, and select Mail Merge from the resulting menu. 
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Creating Form Letters 
Starting Mail Merge 
1. Open Microsoft Word. 
2. Select Letters and Mailings from the Tools menu. 
3. Select Mail Merge from the resulting menu. 
4. Select Letters under Select document type. 
 
Note: At any time, click on Previous at the bottom of the task pane to go back 
to the previous step. 
 
Selecting the Starting Document 
The starting document should be the same type as the mail merge document 
that you want to create. 
1. Click on Next: Starting document at the bottom of the task pane. 
2. Select one of the following under Select starting document: 

• Click on Use the current document to use the active document. 
• Click on Start from a template to use a template. 

° Click Select template. 
° Select a template from the Select Template dialog box. 
° Click OK. 

• Click on Start from existing document. 
° Select a file from the box under Start from existing. 
° Click Open. 
° Optional: If the document you want to use is not shown, click on More Files, and then click Open. 

Select the document, and then click Open. 
 

Selecting the Recipients 
1. Click on Next: Select recipients at the bottom of the task pane. 
2. Select one of the following under Select recipients: 

• Click on Use an existing list to use names and addresses from a file or database. Click on Browse, and in 
the Select Data Source dialog box, select a data source. Click the Open button. 

• Click on Select from Outlook contacts to select recipients from a list of contacts. Click on Choose 
Contacts Folder. Select a folder name and click the OK button. 

• Click on Type a new list to create a new list. 
° Click on Create. 
° Enter the information you want to include, such as title, name, and address in the New Address List 

dialog box. 
° Click the New Entry button to move on to the next entry. 
° Click the Close button when you are finished. 
° Enter a name for the address list in the File name box. 
° Click the Save button. 

3. In the Mail Merge Recipients dialog box, select the recipients you want to include. 
4. Optional: To sort the list, click on the column heading of the item you want to sort by. 
5. Click the OK button when you are finished. 
 
Inserting Merge Fields 
1. Click on Next: Write your letter at the bottom of the task pane. 
2. In the main document, enter the text that you want to appear on every letter. 
3. To insert the merge fields, click on the appropriate location in the document, and click on one of the following 

items: 
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• Click on Address block to insert a formatted address.  (To insert address block merge fields, you can also 
press Alt + Shift + F. Select the field and click the OK button.) 

• Click on Greeting line to insert a formatted salutation. 
• Click on Electronic postage to insert electronic postage. 

(You must install electronic postage software in order to use this feature.) 
• Click on Postal bar code to insert a US postal bar code. 
• Click on More items for a list of additional fields.  (If you click on More items, select the merge fields to 

insert, and click the Insert button.) 
4. In the resulting window, select options, and click the Match Fields button. If any merge fields that you require 

are listed as “not available,” click the arrow and select the appropriate field from the list. Then, click the OK 
button. 
 

Previewing the Merged Document 
1. Click on Next: Preview your letters at the bottom of the task pane. 
2. Optional: To scroll through the merged letters, click the Back and Forward buttons on the task pane. 
3. Optional: Click on Find a recipient or click the Find Entry button on the Mail Merge toolbar to find a specific 

recipient. Enter the recipient’s name, select a location to search, and click the Find Next button. 
4. Optional: To make changes to your recipient list, click on Edit recipient list. Make changes in the Mail Merge 

Recipients dialog box, and click the OK button. 
5. Optional: Click on Exclude this recipient to remove the recipient. 
 
Completing the Merge 
1. Click on Next: Complete the merge at the bottom of the task pane. 
2. Click on one of the following: 

• Click on Print to merge to a printer. Select all records, the current record, or a series of records and click 
on OK. 

•  
• Click on Edit individual letters to personalize your letters or to save them for future use. Select all, the 

current record, or a series of records, and click the OK button. This will open a new document with your 
merged letters. Save, print, or edit the new document just as you would with any Microsoft Word 
document. 

 
Note: To make changes to all the letters, go back to the original main document. 
 
 

Mail Merge Documents 
 
Chances are that you usually need to print labels or envelopes to go with your form letters. When you merge 
addresses onto labels or envelopes, the six basic steps of the Mail Merge wizard stay the same. However, you will 
see different options as you run through the wizard specific to envelopes or labels as opposed to letters. 
 
Printing Labels 
1. Open the Mail Merge task pane. 
2. Select Labels under Select document type. 
3. Click on Next: Starting document. 
4. Select one of the following: 

• Change document layout to create a new sheet of labels 
° Click Label options 
° Select the options you want, such as printer options and label type and size. 
° Click OK. 

• Click on Start from an existing document to start with an existing sheet of labels.  Select a file from the 
box and click Open.  If the document you want is not shown, click More Files. 

5. Click Next: Select recipients. 
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6. Click Next: Arrange your labels. 
7. Insert the merge fields. 
8. Optional: Click the Update all labels button to copy the layout of the first label to all other labels on the page. 
9. Click Next: Preview your labels. 
10. Click Next: Complete the merge at the bottom of the task pane.  Follow the wizard to complete the merge. 
 
Printing Envelopes 
1. Select Print Layout from the View menu. 
2. Open the Mail Merge task pane. 
3. Select Envelopes under Select Document type. 
4. Click Next: Starting document, then either 

• Change document layout to create a new envelope. 
° Click on Envelope options. 
° Click the arrow on the Envelope size box and select the appropriate size.  If the size is not listed, click 

Custom size, enter the Width and Height, and click OK. 
° Optional: To change the font of the delivery or the return address, click the Font button under Delivery 

address or Return address. 
° Optional: To change the position of the delivery or the return address, click the arrows on the From left 

and From top boxes.  Click OK. 
• Click on Start from existing document to start from an existing envelope.  Select the file and click OK. 

5. Click Next: Select recipients. 
6. Click Next: Arrange your envelope. 
7. Optional:  Enter the return address on your envelope in the upper-left corner. 
8. Click in the center of the return address on your envelope to select the address text box. 
9. Insert the merge fields. 
10. Click Next: Preview your envelopes. 
11. Click Next: Complete the merge.  Follow the wizard to complete the merge. 
 
Creating a Directory 
In addition to letters, envelopes, and labels, you can also choose to create a directory. A directory is different from a 
letter in that it places information from multiple records in your data source on the same page. This type of main 
document is very useful for printing a nicely formatted list of the names and addresses in your data source. 
Depending on the kinds of information you have in your data source, you might also use it to print a phone list, a 
catalog, a list of people and their job titles and occupations, and so on. 
 
1. Open the Mail Merge task pane. 
2. Under Select document type, click Directory. 
3. Click Next: Starting document. 
4. Click Next: Select recipients. 
5. Click Next: Arrange your directory. 
6. Optional:  If you have not already done so, enter text, such as labels, that you want to appear on each record in 

the directory. 
7. Insert the merge fields. 
8. Click Next: Preview your directory.  (Word will display a single entry at a time). 
9. Click Next: Complete the merge. 
10. Click on To New Document. 
11. Select all records, the current record, or a series of records, and click the OK button.  Word will open a new 

single document that contains all of the records. 
12. Make changes, save, and print the directory just as you would any other Word document. 
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Sending Merged E-mail Messages 
You can use the Mail Merge Wizard to create and distribute group e-mail messages.  This allows you to send e-
mails to a group of people and personalize the message that each person receives.  Your system must have a MAPI-
compatible e-mail program, such as Outlook, in order to use this feature. 
 
1. Open the Mail Merge task pane 
2. Select E-mail messages under Select document type. 
3. Click on Next: Starting document. 
4. Click on Next: Select recipients. 
5. Click on Next: Write your e-mail message. 
6. If you have not already done so, write your e-mail message. 
7. Insert the merge fields. 
8. Click on Next: Preview your letters. 
9. Click on Next: Complete the merge. 
10. Click on Electronic Mail to send your e-mail messages. 
11. Enter a subject in the Subject line box. 
12. Optional: In the Mail format box, select a mail format. 
13. Under Send records, select all records, the current record, or a series of records. 
14. Click OK to complete the merge and send the e-mail messages using your default e-mail program. 
 
Note: The Mail Merge Wizard will automatically send your e-mail messages without a preview.  Make sure your 
recipient list is correct before proceeding with the final merge step. 
 
Starting a Mail Merge from Outlook 
 
1. Open Microsoft Outlook. 
2. Click on Contacts on the Outlook Bar. 
3. Select the contacts you want to use for the mail merge in one of the following ways: 

• Hold down the CTRL key while clicking on each contact. 
• Create a separate contacts folder and copy on the needed contacts into that folder. 
• Create a custom view of the Contacts folders, such as a view that contains your contacts from a specific 

state. 
(You can only export contacts from one folder at a time.  To export contacts from multiple folders, copy all 
contacts into a new folder or perform a mail merge for each folder.) 

4. Select Mail Merge from the Tools menu. 
5. Under Contacts, click on All contacts in current view or Only selected contacts. 
6. Under Fields to merge, click on All contact fields or Contact fields in current view. 
7. Under Document file, select one of the following: 

• Click on New document to create a new document for the mail merge. 
• Click on Existing document to merge fields to an existing document.  Click the Browse button, select the 

desired document, and click OK. 
8. Optional: To save the list of contacts for future use, check the Permanent file box.  Enter a name for the file in 

the text box. 
9. In the Document type box, select the type of mail merge you want to create.  You can select form letters, 

mailing labels, envelopes or a catalog (directory). 
10. In the Merge to box, select New Document, Printer, or E-mail to export the contacts to a temporary merge 

source file. 
(If you select E-mail, enter a subject the Message subject line box.) 

11. Click OK. 
12. Your new document will open in Word.  Open the Mail Merge task pane. 
13. Follow the wizard to complete the merge. 
 
Note: Mail Merge cannot read addresses in personal distribution lists.  Outlook ignores personal distribution lists 
from your Contacts and will not export them in the mail merge. 


